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Getting Started with P4Win
P4Win is a Windows-Explorer-style program that helps you manage files that are stored 
in the Perforce software configuration management system. Using P4Win, you can view 
files, check them in and out, compare them, and handle conflicts that arise in team 
development settings. P4Win is highly configurable, and you can add custom tools to the 
P4Win menu to perform specialized tasks.

This guide helps you get started with P4Win, and tells you how to perform the basic tasks 
you’re likely to want to do on the first day you start working with P4Win. However, to 
really know what’s going on, you need to understand Perforce in detail. For an overview 
of Perforce, read Introducing Perforce. For details about using P4Win, refer to its online 
help system: from the P4Win Help menu, choose the Help Topics menu item, or press the 
F1 key.

Basic Concepts

P4Win connects to a Perforce server to move files between Perforce depots and your 
workspace, as shown below. 

The precise definitions for these Perforce terms are as follows:

• depot: a file repository on the Perforce server. It contains all existing versions of all files 
ever submitted to the server. There can be multiple depots on a single server. The 
examples in this guide show a single depot.

• server: the program that executes the commands sent by client programs, maintains 
depot files, and tracks the state of workspaces.

• workspace: folders on the client computer where you work on revisions of files that are 
managed by Perforce. 

Workspaces store 
local copies of files 
on...

...your computer, 
running P4V, which 
connects to...

...the Perforce Server, 
which manages...

...depots, repositories 
of files under 
Perforce control
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Perforce Specifications
Perforce Specifications

In addition to files, P4Win lets you manage specifications that define the following 
Perforce entities:

Basic Tasks

The following Perforce terms describe basic tasks you frequently perform using P4Win.

Name Description

Changelist A group of files, with a description explaining how you’ve changed 
them (for example, “Fix bug 000123”). Changelists are assigned 
numbers by the Perforce Server so you can track them. 

Client A specification describing a workspace and specifying how files in the 
depot are mapped to locations in the workspace.

User The identifier that Perforce uses to track who is performing an 
operation.

Job A user-defined unit of work tracked by Perforce. You can associate jobs 
with changelists to track when and how the work is done.

Label A tag you can apply to file revisions in the depot, to group related files.

Branch A specification used to copy a group of related files, for example, to 
create a software release.

When you... What you’re doing is...

Sync a file Retrieving a copy of a file version from the depot.

Open a file Notifying the server that you are changing the file. You can open 
files for add, edit, or delete. When you open a file, the file is added 
to a changelist.

Revert a file Discarding any changes you have made to an open file. If you open 
a file for edit and make changes, then change your mind and revert 
the file, P4Win reloads the last version you got from the depot and 
discards your changes. 

Submit a changelist Updating the depot to reflect any changes you’ve made to open 
files. Submitting is an all-or-nothing operation: if there’s a problem 
submitting one file in a changelist, none of the other files in the 
changelist are updated.
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The P4Win Screen
The P4Win Screen

The P4Win screen resembles the Windows Explorer. The following diagram points out 
the main portions of the screen. Each pane is described in detail in the following sections.

Depot pane: shows files in the depot

Status pane: shows operations and 
results

Toolbar: buttons for changing panes and 
performing common operations

Status line: displays status and file 
information

Right pane: shows changelists, 
jobs, users, clients, branch specs 
or labels
Perforce 2006.2 Getting Started with P4Win 7



The P4Win Screen
The Depot Pane

Depot contents are displayed in a tree in the left pane.

For more 
information...

...about file icons, see the online help topic “About File Icons” in the 
section “Using the P4Win Interface.”

File icons display a lot of detail about file type and status. 

Depots contain... folders, which contain... files.

For example, the file shown above is

checked out by you,
locked for submission, 
and you have an old version in 

in your workspace at the most recent
revision (green dot), and 
a text file (lines on icon)

Here’s another file icon, showing a file that is...

your workspace (represented by 
the “!”).

The text to the right of the file icon
tells you the revision in your
workspace, latest revision in the
depot, and Perforce file type
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The P4Win Screen
Some navigation hints:

• Multiple selections: Shift-click to select contiguous items, Ctrl-click to select non-
contiguous items.

• Select next/previous: Up and down arrows traverse the current level, and right and left 
arrows move the cursor up and down through the folder hierarchy. 

• Open a selected folder: Use the asterisk (*) key on the numeric keypad.

You can control which files are displayed in the depot pane. For example, you might want 
to restrict the list of files to display only the files for the project you’re working on, or 
conversely, you might want to see every file in every depot. The scope is controlled by 
your client specification and the view you choose for the depot pane. 

For more 
information...

...about controlling the files displayed in the depot pane, see the online 
help topics “Managing the Main Window” and “Finding Files in the 
Depot” in the section “Using the P4Win Interface.”

Click here to choose which files are displayed in the depot pane.
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The P4Win Screen
The Right Pane

The right pane displays changelists, jobs, client specifications, users, labels or branch 
specifications. To change the display, click the corresponding toolbar button.

At first, you’ll mostly be working with changelists, so here’s some more information 
about what’s displayed for pending changelists.

For more 
information...

...about displaying information in the right pane, see the related 
“Displaying...” online help topic. For example, for details about 
displaying changelists, see “Displaying Changelists” in the section 
“Managing Files.”

Pending changelists

Submitted changelists

Branch specifications

Users

Jobs

Client specifications

Labels

The triangles represent pending 
(unsubmitted) changelists. Yours are red:
Other clients’ changelists are blue: 

You are required to enter a description
before you submit a changelist. Your
description enables you to track the
reasons for changes.

Changelists are numbered for identification.
The default changelist is assigned a number 
when you submit it.

(unsubmitted) changelists. Yours are red:
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The P4Win Screen
The Toolbar

The P4Win toolbar contains buttons that provide shortcuts for common P4Win 
operations. However, there’s a menu equivalent for every button on the toolbar. Note that 
buttons are gray if an operation is not available. For example, some operations require 
you to select a file first. If no file is selected, the button (and the corresponding menu item) 
are gray. Here’s what the buttons do:

If you forget what a button does, just position the cursor over the button to display a 
tooltip containing a brief explanation: 

The Status Pane

In the status pane at the bottom of the screen, P4Win displays the commands it sends to 
the Perforce server, the results of operations, and, for some P4Win operations, lists of 

Sync
Open for 

Add

Open for

Revert
Lock
Unlock

Bookmarks
Connections

Submit Display in right pane

Stop operation
Change settings
Display server 

Revision history
Diff with depot
View
Launch editor information

edit

delete

edit
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The P4Win Screen
information. For example, if you click this toolbar button: , P4Win display server 
information in the status pane, as shown in the following figure.

P4Win Forms

To define changelists, users, workspaces, labels, jobs, and branches, you enter information 
into forms displayed by P4Win. For example, the following figure shows the changelist 
form.

User Name:      tonyz
Client Name:    my-test-workspace
Client Host:    submariner
Client Root:    c:\p4clients
Client Address: 10.0.0.255:1255
Client Version: 2003.1 44428
Client P4Charset: 
Client Ansi Code Page: 1252  (ANSI - Latin I)
Server Address: 10.0.0.233:1999
Server Date:    2003/05/20 13:12:59 -0700 PDT
Server Version: P4D/FREEBSD4/2003.1beta/44243 (2003/04/25)
Server License: Perforce Software 700 users (expires 2004/01/31) 
Server Root:    /usr/archive/depot/p4-999
Client OS:    Microsoft® Windows XP(TM), Build 2600, Service Pack 1

Click Spec Notes to 
display information
about fields on forms

Click Help to display 
the online help topic
that explains tasks
related to the form
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Setting Up and Using P4Win
Getting Information

Here’s where to look for information when using P4Win.

• Tooltips: to get information about a button or a form field, position the cursor over the 
item in question. P4Win displays a popup containing a brief description of the button or 
field.

• Spec Notes: to get detailed information about form fields, click the  button.

• Online help: to get instructions for performing tasks using P4Win, check the online 
help. To display online help, choose the Help Topics... menu item from the Help menu 
or press F1. Many dialogs include a Help button that takes you directly to the most 
closely-related help topic.

• Status pane: to see the commands that P4Win sends to the server and the results that 
the server returns to P4Win, check the status pane. Some P4Win operations (like 
Help>Show Connection Info) display their output in the status pane.

• Status line: displays local file paths and brief status messages.

Setting Up and Using P4Win

This section tells you how to set up P4Win so you can perform some typical, basic SCM 
tasks. Before you start, ask your Perforce administrator for the following information:

• Host and port of Perforce server. (Your administrator might want to create or direct you 
to a test server, to enable you to experiment without affecting an in-use depot.)

• Your Perforce user name.

• Your Perforce client specification (workspace) name, if one exists.

The following sections tell you how to perform these basic tasks.

• Connecting to a server: to interact with a depot, you must configure P4Win with the 
server host and port, and specify the user and client workspace you want to use.

• Creating a workspace: if your Perforce administrator hasn’t already done this, you need 
to configure an area where you store working copies of files from the depot.

• Adding files to the depot: add files you create in your workspace to the depot so other 
users have access to them.

• Copying files from the depot to the workspace: retrieve copies of files created by other 
users and stored in the depot.

• Editing files: check out and change files that you retrieved.
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Setting Up and Using P4Win
• Displaying changes (diffing): compare different version of files to see what has 
changed.

• Discarding changes: revert to the version of a file you retrieved from the depot and 
overwrite any changes you have made.

• Submitting changes: check in a file that you changed by submitting the changelist in 
which the file is open.

• Deleting files: mark a file in the depot as “deleted.” Note that, in Perforce, previous 
revisions are still accessible.

The examples in the following section use an example depot. Naturally, your own depot 
will contain different files and have a different structure.

If you have questions or want more information about the tasks in the following sections, 
consult the P4Win online help (press F1), the Perforce user documentation (available on 
our Web site), or contact Perforce Technical Support.

Connecting to a server

1. Launch P4Win: from the Windows Start menu, choose Program 
Files>Perforce>P4Win. 
14 Perforce 2006.2 Getting Started with P4Win



Setting Up and Using P4Win
If P4Win has never been run on your computer and no client workspace exists, 
P4Win displays the following dialog (with the name of your computer and login in 
place of “my-workspace” and “my-user”).

If this dialog is displayed, click Cancel to dismiss it. You can define a workspace 
later.

2. Choose Settings...>Switch Port Client User... P4Win displays a dialog where you 
specify connection settings. 

3. Enter the required connection information as follows:

• Port: the server name and port number using the format server:port#

• Client: the name of your client specification (which describes your workspace)

• User: your Perforce user name (if your system administrator hasn’t created one for 
you, Perforce creates the specified user when you connect to the server)
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Setting Up and Using P4Win
The following figure shows an example of correctly-specified connection settings

4. Click OK. The depot pane refreshes to display the depots that the specified server 
contains. 

If no workspace has been defined for you or you specified a client workspace that 
does not exist, the Perforce server displays the following dialog, telling you that you 
must define the client workspace.

You can use this wizard to create a client workspace with the minimum required 
settings or read the next section to learn how to define a client workspace in more 
detail. If your workspace is already configured, skip to “Adding files to the depot” 
on page 18.
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Setting Up and Using P4Win
Creating a workspace

1. Click  to display client specifications in the right pane.

2. In the right pane, right-click and choose New... from the context menu. P4Win 
displays the Create New Client dialog.

3. Specify the name of the workspace you want to create and click OK. P4Win displays 
the client specification form, as shown in the following figure.

4. Change the Root field to ensure that Perforce does not copy files from the depot to 
the root directory of your hard disk. Specify a top-level folder under which you want 
to manage files using P4Win. If there are spaces in the folder names, enclose the 
whole root specification in double quotes ("C:\My Perforce Files").

Important: Set the Root field to 
prevent files from being stored 
in your hard drive’s root 
directory.
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Setting Up and Using P4Win
5. Click Update. P4Win creates the client specification. In the right pane, notice the 

green arrow , which indicates the workspace you are using. 
You can have multiple workspaces on the same computer and switch among them. 
(For example, if you work with more than one server, use a different workspace for 
each one.)

6. Using Windows Explorer, create the root directory.

Now you’re ready to start working with P4Win. 

Adding files to the depot

Create or copy some files to folders located in your client root directory. The type of file is 
not important. For example, use Notepad to create some simple text files, or copy some 
source code files from an existing project, or create some Microsoft Word files. To add 
these files to the depot, perform the following steps.

1. Click the  toolbar button. P4Win displays a file browsing dialog.

2. Browse to your new files, select them and click Open. P4Win displays a confirmation 
dialog listing the files you selected.

3. Click Add Files. P4Win adds them to the default changelist. 

4. To verify that the files are open for add, click the  toolbar button to display 
pending changelists. Expand the default changelist and you’ll see your files listed, as 
shown in the following figure.

For more 
information...

...about client views, which map the depot to your workspace, refer to 
Introducing Perforce. The way you specify your client view affects P4Win 
performance and enables you to display only the portions of the depot 
that you are interested in.
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Setting Up and Using P4Win
5. Right-click the default changelists and choose Submit... P4Win displays the Submit 
form as shown in the following figure.

6. Verify that your files were added by checking the status pane. You’ll see text like the 
following:

Copying files from the depot to the workspace

The simplest way to get a file from the depot to your workspace is to right-click the file in 
the depot pane and choose Sync to Head Revision from the context menu, as shown in 
the following figure.

Required: enter a 
description of your 
change here
Perforce 2006.2 Getting Started with P4Win 19



Setting Up and Using P4Win
To verify that the file was copied to your workspace, check the status pane for messages 
like the following:

You can sync an entire folder, including all the files in its subfolders, the same way.

Editing files

To change a file in the depot, you must do the following:

1. Open the file for edit, which notifies the Perforce server that you intend to change the 
file. The server adds the file to a changelist.

2. Make and save changes to the file, using its related editing application.

3. Submit the changelist containing the file.

When you submit the changelist, your changes are copied to the depot, and other users 
can now obtain them. Here’s how you edit files using P4Win:

1. In P4Win, right-click a file and choose Open for Edit, as shown in the following 
figure.

To verify that your file is open for edit, click the  toolbar button to display 
pending changelists. Expand the default changelist and you’ll see your file listed as 
shown below.

Also check the status pane for the following message.

The red check mark means you’ve opened the file for edit
20 Perforce 2006.2 Getting Started with P4Win



Setting Up and Using P4Win
2. Using the appropriate editing application, make some changes to the file and save 
the file.

Displaying changes (diffing)

After you make changes to a file, you might want to see a comparison between your file 
and the original. To display your changes, right-click the file and choose Diff File Against 
Depot... 

P4Win launches a “diff” program that highlights the differences between your version of 
the file and the one in the depot, as shown below.

Deleted lines are shown in red, new lines in blue.
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Setting Up and Using P4Win
When you’re done examining your changes, dismiss the diff program by closing its 
window.

Discarding changes (reverting)

You might decide you want to discard the changes you’ve made to the file and leave the 
version in the depot unchanged. If you’d rather check your changed file into the depot, 
skip to “Submitting changes” on page 23.

To discard your changes:

1. Right-click the file and choose Revert.

P4Win displays a confirmation prompt. 

2. Click Yes to discard changes. 
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Setting Up and Using P4Win
To verify that the file was reverted, check the status pane for a message like the following.

You can revert any open file. For example, if you have a file open for add or delete, then 
change your mind about adding or deleting it, revert it.

Submitting changes

To check your changed file into the depot, you submit the changelist in which the file is 
open for edit. If you reverted the file as described in the previous section, open it for edit 
and make some changes as described in “Editing files” on page 20.

To submit your changes to the depot, perform the following steps.

1. Right-click the default changelist and choose Submit... from the context menu. The 
Change Specification dialog is displayed.
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Setting Up and Using P4Win
2. Enter a description of your change in the Description field and click Submit. 

To verify that your change was submitted, check the status pane. You’ll see a message like 
the following:

Note that the file revision number has been incremented, too:

Deleting files

To delete a file in the depot, you open it for delete (which places the file in a changelist) 
and submit the changelist. Perforce deletes a file by creating a new head revision marked 
“deleted.” Note that all previous revisions of the file are retained in the depot. 

To delete a file:

1. Right-click the file and choose Open for Delete. 

To verify that the selected file is open for delete, check the default changelist. 

The revision number has been increased from 3 to 4.

The red “x” indicates the file is open for delete
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Setting Up and Using P4Win
2. Right-click the default changelist and choose Submit... from the context menu. The 
Change Specification dialog is displayed.

3. Enter a description of your change and click Submit. 

To verify that your change was submitted, check the status pane. You’ll see a message like 
the following:
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Important and Useful Features
To check the state of the file in the depot, choose View>Show Deleted Depot Files and 
browse to the files. Note that the file revision number has been incremented, too:

Important and Useful Features

P4Win is a full-featured product. The following sections describe some of the most useful 
features, but to get the most out of P4Win, consult its online help as you work. Be sure to 
read Introducing Perforce to get a full understanding of what Perforce does.

Right-clicking and context menus

If you right-click an object, P4Win displays a context menu containing common 
operations. For example, when you right-click a file in the depot pane, P4Win displays the 
following context menu.

“5” means there are five file revisions in the

“0” means there is no file revision in your workspace.

 depot; revision 5 is marked “deleted.”

Right-click an object
to display its context 
menu
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Important and Useful Features
You can right-click any object, and right-clicking is a useful alternative to searching 
through full menus to locate a desired option. You can also display the context menu for a 
selected object by pressing the Application key, which is located between the Alt and Ctrl 
keys to the right of the space bar on most keyboards.

Configuring P4Win

P4Win is highly configurable. To view the settings you can configure, click the  
toolbar button to display the Options dialog, shown in the following figure.

Application key on Windows keyboard

Click the list item in the left pane to display the corresponding settings in the right pane.
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Important and Useful Features
If you are using P4Win at a large site, where many users access the same Perforce Server, 
you can configure P4Win to minimize its impact on the server.

Using drag and drop

P4Win supports some useful drag and drop shortcuts. For example, to display the 
submitted changelists that affect a file:

1. Click the  toolbar button. The right pane displays submitted changelists.

2. From the depot pane, drag the file to the right pane. The right pane is refreshed to 
display only the submitted changelists that include the selected file.

For more 
information...

...about configuring P4Win for use at large sites, see the online help 
topic “Maximizing P4Win Performance” in the section “Configuring 
P4Win Performance.”

For more 
information...

...about drag and drop shortcuts, see the online help topic “P4Win 
Shortcuts” in the section “Using the P4Win Interface.”

Drag this file and drop it on the right pane 
to see the changelists that affected it.
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Beyond the Basics
Beyond the Basics

This guide tells you how to start working with files using P4Win and points out important 
basic features, but P4Win enables you to do much more: create jobs, branch groups of 
files, and handle the conflicts that arise in team development settings. However, there are 
limits to what you can do with P4Win: there is a set of administrative functions that 
P4Win does not support. These administrative tasks are done using the Perforce 
command-line client (p4). For details, see the Perforce Command Reference.

To become expert with P4Win:

• Consult the online help

• Use the Spec Notes feature

• Read the status pane

• Learn drag and drop features to simplify operations on large sets of files

• Use P4Win views and filtering features to enable you to selectively display information

To get the whole picture, read Introducing Perforce and the Perforce System Administrator’s 
Guide. These documents, which are available from the Perforce web site, describe the full 
set of features that the Perforce Server provides. 
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